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[bookmark: _Toc296147648]Understanding Web Parts
Similar to lists, Web parts are some of the most commonly customized objects in SharePoint. Web parts also provide a great opportunity for developers to leverage some very powerful capabilities that are native to ASP.NET. Developers work with Web parts in a couple of different ways. For example, you might create a Web part as an individual server control that you deploy to your SharePoint site. You can also create SharePoint Web part pages that leverage existing Web parts (whether those Web parts are custom or native to SharePoint), or integrated through a Web part connection (that is, connected Web parts).
As you build out server controls or pages to host your Web parts, you can use tools such as Visual Studio 2010 or SharePoint Designer 2010. If you have a more dynamic UI for your Web parts (for example, a Silverlight-based UI), then you may opt for Expression Blend as well. In Visual Studio 2010, you’ll find an enhanced designer experience with the Visual Web part project template that makes it much easier to drag and drop controls onto the designer surface to create custom Web parts. You can also use Visual Studio to leverage the ASP.NET Web part framework - using all of the ASP.NET controls (for example, calendar, textbox, datagrid, and so on) to create your custom Web part. 
After you’ve built and deployed Web parts to a SharePoint site, end users can then modify a SharePoint site depending on the following:
· The level of permissions they have in SharePoint
· The different out-of-the-box Web parts that are available to them (which would depend on the version of SharePoint they’re using)
· The type of custom Web parts you have deployed to that SharePoint site
The more permissions users have for a site, the more they can customize and design the site for the users of that site.
Once a Web part is on a page, users can configure the Web part(s) on that page. For example, users can minimize, remove, or hide the Web part. They can also drag the Web part to a different part of the Web part page (into a different Web part zone), alter the properties of the Web part (to change the look, feel, or appearance), or even export/import the Web part for use in other pages or sites.
When you deploy a Web Part to SharePoint, it shows up in the Web Part Gallery. The Web Part Gallery is a management application that provides a way to manage Web parts for a site collection. With the Web Part Gallery, you can do things like view, edit, upload, delete, and manage permissions against Web parts. You access the Web Part Gallery within a site collection by clicking Site Actions ➪ Site Settings, and, under Galleries, select Web Parts.
[image: ]
What helps users integrate Web parts into a SharePoint site is the in-context ribbon experience that surfaces the different Web parts that live in the Web Part Gallery and makes them available for users to add to a Web part page. For example, if you click Site Actions ➪ Edit Page, this exposes the Insert tab. If you click the Web part ribbon control, this exposes all of the available Web parts for the SharePoint site - which includes custom Web parts you have built and deployed to your site.
[image: ]
[bookmark: _Toc296147649]Working with Web Parts
You can customize pages on a SharePoint site by adding or changing Web Parts (Web Part: A modular unit of information that consists of a title bar, a frame, and content. Web Parts are the basic building blocks of a Web Part Page.). Web Parts enable you to add diverse functionality to pages, such as displaying document libraries and charts on pages, without having to write code.
[bookmark: _Toc274046161][bookmark: _Toc241060385][bookmark: _Toc296147650]Add a Web Part to a page
To edit a page you must have at least the permissions obtained by being added to the default <Site Name> Members SharePoint group for the site.
1. From a page, in the ribbon, click the Page tab, and then click the Edit command.
[image: Image: Edit command of the Edit tab]
Note If the Edit command is disabled, you may not have the permissions to edit the page. Contact your administrator.
2. Click on the page where you want to add a Web Part, click the Insert tab, and then click Web Part.
[image: Web Part command]
3. Under Categories, select a category, such as Lists and Libraries, select the Web Part that you want to add to the page, such as Announcements, and then click Add.
[image: Web Part picker]
4. When you select a Web Part, information about the Web Part is displayed in About the Web Part.
5. When you have finished editing the page, click the Page tab, and then click Save & Close.
[bookmark: _Toc244346431][bookmark: _Toc245204803][bookmark: _Toc274046162][bookmark: _Toc296147651]Move a Web Part on a page
1. From a page, in the ribbon, click the Page tab, and then click the Edit command.
[image: Image: Edit command of the Edit tab]
Note If the Edit command is disabled, you may not have the permissions to edit the page. Contact your administrator.
2. On the page, select the Web Part.
· For a wiki type of page, also referred to as a content page:
1. In the Format Text tab, click Cut or use the Ctrl X keyboard shortcut.
2. Click on the page where you want to move the Web Part.
3. In the Format Text tab, click Paste or use the Ctrl V keyboard shortcut.
· For Web Part pages, select the Web Part and drag it to desired location on the page.
3. When you have finished editing the page, click the Page tab, and then click Save & Close.
[bookmark: _Toc244346432][bookmark: _Toc245204804][bookmark: _Toc274046163][bookmark: _Toc296147652]Minimize or restore a Web Part on a page
You can configure a Web Part to be minimized by default on a page. You might do this if a page seems crowded. The readers of the page can restore the Web Part while they are reading the page. If they close and then reopen the page, the Web Part will be minimized again.
1. From a page, in the ribbon, click the Page tab, and then click the Edit command.
[image: Image: Edit command of the Edit tab]
2. On the page, point to the Web Part, click the down arrow, and then click Minimize. You restore a list or library the same say.
[image: Minimize]
3. When you have finished editing the page, click the Page tab, and then click Save & Close.
The following image is an example of a page where the Tasks list and Product Planning document library Web Parts are minimized.
[image: Minimized list or library on page]
[bookmark: _Toc244346433][bookmark: _Toc245204805][bookmark: _Toc274046164][bookmark: _Toc296147653]Delete a Web Part from a page
Note This procedure does not delete the Web Part from the site. It only deletes it from the page.
1. From a page, in the ribbon, click the Page tab, and then click the Edit command.
[image: Image: Edit command of the Edit tab]
2. Point to the Web Part that you want to remove from the page, click the down arrow, click Delete, and then click OK.
[image: Minimize]
3. When you have finished editing the page, click the Page tab, and then click Save & Close.
[bookmark: _Toc296147654]Changing Web Part Properties
If you are a Web page owner, you can configure Web Parts in several ways. From your Web browser, you can change Web Part properties by using the Web Part Maintenance Page. You can further configure Web Parts by using a SharePoint compatible Web design program, such as Microsoft SharePoint Designer 2010.
[bookmark: 1][bookmark: _Toc242692808][bookmark: _Toc261355465][bookmark: _Toc296147655]Change Web Part properties by using the tool pane
You can change the attributes of a Web Part by assigning values to its Web Part properties. All Web Parts share a set of common properties that allow you to specify attributes for the appearance, layout, and other information. A Web Part can also have custom properties that apply only to that Web Part.
1. On the Site Actions menu [image: Site Actions Menu], click Edit Page.
2. Point to the Web Part, click the down arrow, and then click Edit Web Part.
3. The common and custom properties of the Web Part appear in the tool pane. For example, common properties you can change might include the Web Part name, size, and other layout parameters. Custom properties are those settings specific to a given Web Part.
Note If you are in a personal view, the Web Part developer may have limited which custom properties can be changed for that Web Part.
4. To save your changes and close the tool pane, click OK. To view your changes without closing the tool pane, click Apply. 
Find links to more information about customizing different types of Web Parts in the See Also section.
[bookmark: 2][bookmark: _Toc242692809][bookmark: _Toc261355466][bookmark: _Toc296147656]Open and use the Web Part Maintenance Page 
If you encounter problems with a Web Part or Web Part connection on a page, you can use the Web Part Maintenance Page to help isolate and fix your problem. You must have the appropriate permissions to use the Web Part Maintenance Page.
Tip If you are not sure which Web Part or Web Part connection is causing a problem on your Web Part Page, it is a good idea to work in a step-by-step fashion by closing one Web Part at a time and then browsing through the Web Part Page (click Go Back to My Web Part Page) to see if that fixes the problem. After you identify the problem Web Part, you can consider resetting or deleting it.
1. Open the document library that contains the page. 
2. Point to the name of the page, click the down arrow, and then click Edit Properties.
3. Click Open Web Part Page in maintenance view to display the Web Part Maintenance Page.
Note To access the Web Part Maintenance Page for a page that is not stored in a document library, such as the site home page, append Contents=1 to the end of the URL for the page.
4. Verify that you are in the view that you want, either a personal view or shared view. If you need to switch views, do one of the following: 
· If you are in a personal view and you want to switch to a shared view, click Switch to shared view. 
· If you are in a shared view and you want to switch to a personal view, click Switch to personal view. 
5. Select one or more Web Parts, and then do one of the following: 
· To move a Web Part to the Web Part Page gallery, click Close.
· To remove personal property values and revert to the shared property values of the Web Part, click Reset. You are prompted for confirmation before resetting a Web Part. 
· To permanently delete a Web Part from the page, click Delete. You are prompted for confirmation before deleting a Web Part. 
Note If the Allow editing in personal view property is unchecked, a Web Part may only be deleted in a shared view.
6. When you finish, click Go Back to Web Part Page.
Note You cannot use the Web Part Maintenance Page to close, reset, or delete a static Web Part (that is, a Web Part outside a Web Part zone).
To maintain a static Web Part, you must use a SharePoint-compatible Web design program 
[bookmark: 3][bookmark: _Toc242692810][bookmark: _Toc261355467][bookmark: _Toc296147657]Common properties of Web Parts
All Web Parts share a common set of properties that control their appearance, layout, and advanced characteristics.
The common Web Part properties that you see in the tool pane may be different from what is documented in this section for several reasons: 
· To see the Advanced section in the tool pane, you must have appropriate permission. 
· For a specific Web Part, a Web Part developer may have chosen not to display one or more of these common properties or may have chosen to create and display additional properties that are not listed below in the Appearance, Layout, and Advanced sections of the tool pane. 
· Some permission and property settings may disable or hide Web Part properties. 
[bookmark: _Toc261355468]Appearance
	Property
	Description

	Title
	Specifies the title of the Web Part that appears in the Web Part title bar.

	Height
	Specifies the height of the Web Part.

	Width
	Specifies the width of the Web Part.

	Chrome State
	Specifies whether the entire Web Part appears on the page when a user opens the page. By default, the chrome state is set to Normal and the entire Web Part appears. Only the title bar appears when the state is set to Minimized.

	Chrome Type
	Specifies whether the title bar and border of the Web Part frame are displayed.


[bookmark: _Toc261355469]Layout
	Property
	Description

	Hidden
	Specifies whether the Web Part is visible when a user opens the page. If the check box is selected, the Web Part is visible only when you are designing the page and has the suffix (Hidden) appended to the title. 
You can hide a Web Part if you want to use it to provide data to another Web Part through a Web Part connection, but you don't want to display the Web Part.

	Direction
	Specifies the direction of the text in the Web Part content. For example, Arabic is a right-to-left language; English and most other European languages are left-to-right languages. 

	Zone
	Specifies the zone on the Web Part Page where the Web Part is located.
Note Zones on the Web Part Page are not listed in the list box when you do not have permission to modify the zone.

	Zone Index
	Specifies the position of the Web Part in a zone when the zone contains more than one Web Part. 
To specify the order, type a positive integer in the text box. 
If the Web Parts in the zone are ordered from top to bottom, a value of 0 means that the Web Part appears at the top of the zone. If the Web Parts in the zone are ordered from left to right, a value of 1 means that the Web Part appears on the left of the zone. 
For example, when you add a Web Part to an empty zone that is ordered from top to bottom, the Zone Index is 0. When you add a second Web Part to the bottom of the zone, its Zone Index is 1. To move the second Web Part to the top of the zone, type 0, and then type 1 for the first Web Part.
Note Each Web Part in the zone must have a unique Zone Index value. Therefore, changing the Zone Index value for the current Web Part can also change the Zone Index value for other Web Parts in the zone.


[bookmark: _Toc261355470]Advanced
	Property
	Description

	Allow Minimize 
	Specifies whether the Web Part can be minimized. 

	Allow Close
	Specifies whether the Web Part can be removed from the Web Part Page.

	Allow Hide
	Specifies whether the Web Part can be hidden.

	Allow Zone Change
	Specifies whether the Web Part can be moved to a different zone. 

	Allow Connections
	Specifies whether the Web Part can participate in connections with other Web Parts.

	Allow Editing in Personal View
	Specifies whether the Web Part properties can be modified in a personal view.

	Export Mode
	Specifies the level of data that is permitted to be exported for this Web Part. Depending on your configuration, this setting may not be available.

	Title URL
	Specifies the URL of a file containing additional information about the Web Part. The file is displayed in a separate browser window when you click the Web Part title.

	Description
	Specifies the ScreenTip that appears when you rest the mouse pointer on the Web Part title or Web Part icon. 

	Help URL
	Specifies the location of a file containing Help information about the Web Part. The Help information is displayed in a separate browser window when you click the Help command on the Web Part menu.

	Help Mode 
	Specifies how a browser will display Help content for a Web Part. 
Select one of the following:
· Modal Opens a separate browser window, if the browser has this capability. A user must close the window before returning to the Web page. 
· Modeless Opens a separate browser window, if the browser has this capability. A user does not have to close the window before returning to the Web page. This is the default value. 
· Navigate Opens the Web page in the current browser window. 
Note Even though custom Microsoft ASP.NET Web Parts support this property, default Help topics open only in a separate browser window.

	Catalog Icon Image URL
	Specifies the location of a file containing an image to be used as the Web Part icon in the Web Part List. The image size must be 16 by 16 pixels.

	Title Icon Image URL
	Specifies the location of a file containing an image to be used in the Web Part title bar. The image size must be 16 by 16 pixels.

	Import Error Message
	Specifies a message that appears if there is a problem importing the Web Part.



[bookmark: _Toc296147658]Working with List Web Parts
[image: Hide All]Hide All
[bookmark: _top]You can customize pages by displaying lists and libraries on them. You might find this helpful if, for example, you want to have the documents, calendar, and tasks for a project all on one page. You display a list or library on a page by adding a Web Part to the page.
To add a list or library to a page, you must have at least the permissions (permissions: The specific security settings that allow or restrict access to a given item, list, library, or site.) obtained by being added to the default <Site Name> Members group for the site. To create a list, you must have at least the permissions obtained by being added to the default Designer group for the site.
[bookmark: _Toc244578560][bookmark: _Toc274131183][bookmark: _Toc296147659]Add an existing list or library to a page
1. From a page, in the ribbon, click the Page tab, and then click the Edit command.
[image: Image: Edit command of the Edit tab]
Note If the Edit command is disabled, you may not have the necessary permissions to edit the page, contact your administrator.
2. Click on the page where you want to display an existing list or library, in the ribbon, click the Insert tab, and then click Existing List.
3. Under Web Parts, select the list or library that you want to add to the page, such as Tasks, and then click Add. The page refers to Web Parts because you are using the List View Web Part to display the selected list or library.
When you select a list or library, a description of the list or library is displayed under About the Web Part.
4. When you have finished editing the page, click the Page tab, and then click Save.
The following image is an example of a list that was added to a page by using the previous procedure.
[image: Tasks list on page]
[bookmark: _Toc244578561][bookmark: _Toc274131184][bookmark: _Toc296147660]Create a new list or library and add it to a page
1. From a page, in the ribbon, click the Page tab, and then click the Edit command.
[image: Image: Edit command of the Edit tab]
Note If the Edit command is disabled, you may not have the necessary permissions to edit the page. Contact your administrator.
2. Click on the page where you want to display a new list or library, in the ribbon, click the Insert tab, and then click New List.
Note If the List command is disabled, you may not have the necessary permissions to create a list. Contact your administrator.
3. In the Create List dialog box, type the List Title, select the type of list or library that you want to add to the page, such as Document Library, and then click OK.
[image: Create list]
4. When you have finished editing the page, click the Page tab, and then click Save.
The following image is an example of a document library that was added to a page by using the previous procedure.
[image: Product planning library on page]
[bookmark: _Toc244578562][bookmark: _Toc274131185][bookmark: _Toc296147661]Change the view for a list or library on a page
You may want to change the view that you use to display the list or library on a page. For example, you may want to show a view with fewer items that are the most relevant to your team’s work.
1. From a page, in the ribbon, click the Page tab, and then click the Edit command.
2. On the page, point to the list or library, click the down arrow, and then click Edit Web Part.
3. In the properties for the list or library on the page, click the Selected View down arrow, select the desired view, and then click OK.
[image: View properties]
If the available views do not meet your needs, you can go to the list or library and create new views. The next time that you modify the Web Part, the views will be available in Selected Views.
[bookmark: _Toc244578563][bookmark: _Toc274131186][bookmark: _Toc296147662]Important Web Parts
[bookmark: _Toc296147663]Content Query Web Part
You can create dynamic views of your content by using the Content Query Web Part. You can customize the query that defines what content is displayed, and can customize the view settings that determine how that content is presented on the page.
[bookmark: _Toc245646704][bookmark: _Toc276562693]What is the Content Query Web Part? 
The Content Query Web Part displays a dynamic set of items based on a query that you build by using a Web browser. You use the query to specify which items are displayed, and you can set presentation options to determine how those items are displayed on the finished page.
The items that are displayed by the Content Query Web Part always reflect the most current set of items that are retrieved by the query that the page viewer is authorized to see. The query is run whenever the page that contains the Content Query Web Part is viewed. If new content is added and it meets the query criteria, it is automatically displayed by the Content Query Web Part.
Note There may be a delay of a few minutes between the time that new content is added and when it is displayed by the Content Query Web Part.
After you add the Content Query Web Part to a page, you edit the Web Part to change which items it displays and how it displays them. To edit the Content Query Web Part, point to the Web Part, click the down arrow at the top right corner of the Web Part, and then click Edit Web Part. The tool pane opens and displays the Content Query Web Part settings.
There are five categories of settings:
· Query Use these settings to build the query. 
· Presentation Use these settings to customize the presentation of the items that are retrieved by the query. 
· Appearance Use these settings to adjust the appearance of the Web Part itself. You can change the title, height, width, and chrome (the design and navigation elements that frame the Web Part) of the Web Part by changing these settings. 
· Layout Use these settings to adjust the layout of the Web Part. You can change whether the Web Part is visible, whether it is directional (left-to-right, right-to-left, or neither), which zone the Web Part appears in (top, left column, or right column), and the zone index of the Web Part. 
· Advanced Use these settings to adjust a variety of more advanced Web Part options. 
[bookmark: _Toc245646705][bookmark: _Toc276562694]Build a Query
You can specify which content the query retrieves by using the following Query settings.
Source This setting determines the scope of your query. This setting is required. There are three options:
· Show items from all sites in this site collection Select this option to query the entire site collection. This is the default setting. 
· Show items from the following site and all subsites Select this option to limit the query to a particular site in the site collection. You can type the address for the site, but we recommend that you use the Browse button to select a site. When you click Browse, the Select Site Web Part dialog box opens and displays a tree view of the site collection. Click the site that you want to query, and then click OK. 
· Show items from the following list: Select this option to limit the query to a particular list or library in the site collection. You can type the address for the list, but we recommend that you use the Browse button to select a list or library. When you click Browse, the Select List or Library Web Part dialog box opens and displays a tree view of the site collection. If the list or library that you want to query is located within a particular site, click the plus sign (+) next to that site's name. When you see the list or library that you want to query, click it, and then click OK. 
List Type This setting is required. You can choose any type of list that is in your site collection. The type of list that you choose determines which of the lists or libraries that are in the scope of the query are processed by the query. 
Content Type There are two settings for Content Type: Content Type Group and Content Type. These settings are optional. You can use these settings to limit the query to items of particular content types that are defined for your site collection. 
Audience Targeting This setting is optional. If you select Audience Targeting, the query filters the content that it retrieves to show only content that is targeted to the audience that the page viewer belongs to. Audiences are defined system-wide, and cannot be changed by using the Content Query Web Part. This setting only determines whether the Web Part respects Audience Targeting.
When you select Audience Targeting, a second setting becomes available: Include items that are not targeted. When you select this setting, any content that is not explicitly targeted to an audience is retrieved by the query, regardless of who is viewing the page. If you select Audience Targeting but do not select this setting, content that is not explicitly targeted to an audience is not retrieved by the query.
Additional Filters This setting is optional. You can use this setting to further limit the content that the query retrieves. Choose a filter field, a comparison operator, and enter your criteria. For example, you can use the filter field Author, the comparison operator Is Equal To, and the criterion Toni Poe, to limit the query's results to items that were authored by Toni Poe. Filter options very depending on the filter filed that you chose. For example, if you select the Created By field, you are presented with the additional options:
· [Me] will display content created by you.
· Type or browse to the person, so the Web Part will display content created by them.
· Custom Value or Query You may also enter these tokens as filter values:
· PageFieldValue: field name – You can use this setting to filter content dynamically based on the specified field of the current page.
· PageQueryString: query string parameter name – You can use this setting to filter content dynamically based on the value of the query string property specified in the current page URL.
Note If the page field value or query string parameter value is null, the filter will not be included in the query.
You can specify up to three filters by using the Additional Filters setting. If you use more than one filter, you must specify how the filters are collectively applied by using the And and Or options that precede the second and third filter.
[bookmark: _Toc245646706][bookmark: _Toc276562695]Customize the data presentation
You can customize the presentation of the content that the query retrieves by using the following Presentation settings. All of these settings are optional.
Grouping and Sorting Use these settings to arrange the items that are retrieved by the query. 
· Group Items By Select a field to use to separate items into groups. For example, if you want to group items based on who authored them, select Author.
· When you select a field to group by, you can specify whether the items are arranged in ascending or descending order by using the Show groups in ascending order and Show groups in descending order options.
· Number of Columns Specify the number of columns that you want to use to arrange the items. Items can be arranged in up to five columns. 
· Sort Items By Select a field to use to sort the items. If you have specified that items are grouped, the items are sorted within those groups.
· When you select a field to sort by, you can specify whether the items are arranged in ascending or descending order by using the Show items in ascending order and Show items in descending order options.
· Limit the number of items to display You can limit the number of items that are displayed by setting this option. If you do not specify a limit, all items that are retrieved by the query are displayed. If there are a large number of items, the page expands to accommodate them. 
Styles Use these settings to apply visual styles to groups and items. 
· Group style Select a style to apply to the group heading. For example, if you group by author, each group of items is headed by the author name, and the author name appears in the style that you specify by using this setting. 
· Item style Select a style to apply to items
Fields to display Depending on the scope of your query, you can select one or more site or list columns whose values you want to show in the display slots for this style. To specify a column from a particular group, type the name of the group in square brackets after the column name, for example, Column [Group]. Be sure to separate each column you enter with a semi-colon.
If the first column you specify has a blank value, the Web Part will show the value of the subsequent column.
Feed You can choose to have your Content by Query Web Part serve as an RSS Feed. This gives page viewers the option of subscribing to the query results of the Web Part, so that they receive new items when they appear, without having to revisit the page. Use these settings to specify a title and description for the RSS Feed. 
· Feed title Enter a name that you want to use for the RSS Feed. This name helps subscribers to identify the feed in their RSS reader. 
· Feed description Enter a description that you want to use for the RSS Feed. This description helps subscribers to identify the feed in their RSS reader. 
[bookmark: _Toc296147664]Page Viewer Web Part
You can use the Page Viewer Web Part to display a Web page, file, or folder on a SharePoint page. You enter a hyperlink; file path, or folder path to link to the content. 
Notes 
· You can use the Page Viewer Web Part only in a browser that supports the HTML IFRAME element.
· Displaying a file or a folder requires Microsoft Internet Explorer.
[bookmark: _Toc261266199][bookmark: _Toc282433245]Ways you can use the Page Viewer Web Part
You can use the Page Viewer Web Part to display: 
· A favorite Internet news source in a dedicated news summary section of a SharePoint page.
· A list of active work group files on a server that you want to view on a regular basis.
· A frequently used document or spreadsheet.
[bookmark: _Toc261266200][bookmark: _Toc282433246]How the Page Viewer Web Part displays a Web page in a SharePoint page
The linked content of the Page Viewer Web Part is isolated from other content on the page by using the HTML IFRAME element. This element ensures that any HTML elements that are displayed as content in the Page Viewer Web Part do not conflict with other HTML elements on the page. For example, the page may already contain an HTML FORM element, and the page would not be displayed correctly if the linked content also contained an HTML FORM element that was not inside the HTML IFRAME element.
The Page Viewer Web Part displays content asynchronously from the rest of the page. This means that you can view and use other Web Parts on the page if the link happens to take a long time to return the content.
[bookmark: _Toc282433247][bookmark: BM3][bookmark: _Toc261266202][bookmark: _Toc282433248]Specify the Web Page, folder or file (custom properties)
To edit the properties of the page viewer Web part,
· If you have not yet configure the page viewer Web Part, in the page viewer Web Part, click open tool pane.
· Point to the Web Part, click the down arrow, and then click Edit Web Part.
The Web Part properties display in the tool pane. You can use the following descriptions to help configure the Web Part custom properties:
	Property
	Description

	Web Page, Folder, or File group
	Specifies the kind of content that you want to display in the Page Viewer Web Part.
Select one of the following:
· Web Page Select this option if you want to display a Web page as the content of the Page Viewer Web Part. This option automatically enters the Hypertext Transfer Protocol (http://) in the Link text box. This is the default value.
· Folder Select this option if you want to display a list of files in a folder.
· File Select this option to display the contents of a file. The file opens either in a separate browser window or inside the Web Part if the application that opens the file supports inline activation for that file in the browser window.

	Link
	Specifies a hyperlink, folder, or file to link to the content that you want displayed in the Page Viewer Web Part: 
· If you select Web Page earlier in this section, you must enter a valid hyperlink. The two valid hyperlink protocols that you can use are as follows:
· Hypertext Transfer Protocol (http://)
· Hypertext Transfer Protocol with privacy, which uses Secure Sockets Layer (SSL) encryption (https://)
You can use an absolute URL or a relative URL. However, you cannot use a file path.
· If you select Folder earlier in this section, you must enter a valid local or network folder. Displaying a folder requires Microsoft Internet Explorer.
· If you select File earlier in this section, you must enter a valid file path. Displaying a file requires Microsoft Internet Explorer. You can also click Browse to locate the file.


[bookmark: _Toc261266203][bookmark: _Toc241408988][bookmark: OLE_LINK1][bookmark: OLE_LINK2][bookmark: _Toc282433249]
[bookmark: _Toc296147665]Content Editor Web Part
You can use the Content Editor Web Part to add formatted text, tables, hyperlinks, and images to a Web page.
Important The Content Editor Web Part is intended for adding content to a page, which may include hyperlinks. However, this Web Part is not designed to connect to a Web site. If you need to connect a Web Part to a Web site, consider using the Page Viewer Web Part.
[bookmark: BM1][bookmark: _Ways_you_can][bookmark: _Toc257192466][bookmark: _Toc257194287]Ways you can use the Content Editor Web Part
You can use the Content Editor Web Part to add:
· An introductory, formatted paragraph to a page.
· A table of instructions to explain a chart on your page, the data that is used in the chart, and how the chart was created.
· A set of hyperlinks to more information.
[bookmark: _Toc257192467][bookmark: _Toc257194288][bookmark: _Add_content_to][bookmark: _Toc257192468][bookmark: _Toc257194289]Add content to the Content Editor Web Part
There are two ways you can add content to the Content Editor Web Part. You can: 
· Type content directly into the Web Part To do this, point to the Content Editor Web Part, click the down arrow, and then click Edit Web Part. Once you are in Edit mode, you can type text directly into the Content Editor Web Part. 
· Link to existing content by entering a hyperlink to a text file that contains HTML source code To do this, point to the Content Editor Web Part, click the down arrow, and then click Edit Web Part. In the tool pane, type the URL in the Content Link text box. The two valid hyperlink protocols that you can use are:
· Hypertext Transfer Protocol (http://)
· Hypertext Transfer Protocol with privacy, which uses Secure Sockets Layer (SSL) encryption (https://)
You can use an absolute URL or a relative URL. However, you cannot use a file path.
Note If you enter a URL into the Content Editor Web Part as a relative link, the link converts to an absolute URL when the entry is saved. This automatic conversion can be an issue if you are deploying content from a staging environment to production, where absolute URLs reference the original server's name. To address this automatic conversion issue, you will need to edit the Content Editor Web Part on the production server and update the URLs manually.
Important If the Content Link property links to a file that is located outside the site and the site does not have anonymous user access enabled, you cannot access the file. For assistance, contact your site administrator.
[bookmark: _Combine_edited_and][bookmark: _Toc257192469][bookmark: _Toc257194290]Combine edited and linked content
You can combine edited and linked content to provide both primary and secondary information. For example, you can provide an error message as secondary information in the edited content, in case the linked content or primary information is not available. When you combine both edited and linked content, the linked content is always used first. If the linked content is not accessible, the edited content is used.
[bookmark: BM4][bookmark: _Format_content_in][bookmark: _Toc257192470][bookmark: _Toc257194291]Format content in the Content Editor Web Part
In SharePoint Foundation 2010, you can type content directly into the Content Editor Web Part and format it using the editing tools available from the ribbon. To access these editing tools, from the Page tab, in the ribbon, click Edit. 
The ribbon includes six groups of formatting options which are described in the table that follows. 
	Group
	Description

	Font 
	Use these tools to format selected text in the Web Part. You can modify the font type, size, and color, make text bold or italicized, highlight selected text, and strike through it, among other things. 

	Paragraph 
	Use these tools to format selected paragraphs in the Web Part. You can modify the alignment of the text, indent it, create a numbered or bulleted list, and change the order in which information in the paragraph is displayed.

	Styles
	Apply a preformatted style to selected text. To preview a style, select the text you want to format, and then drag your cursor over the style option you want to preview.

	Spelling 
	Check the spelling of text on the page. This option is available only when the spell checking feature is installed.

	Layout 
	Create or remove columns, headers, or footers on the page. 
Note This option affects the entire page, not just the content in the Content Editor Web Part.

	Markup
	Use these tools to insert specific HTML elements into the content. You can select a preformatted style from the Markup Styles drop-down menu, or create your own by accessing the HTML Editor from the HTML drop-down menu. You can also mark text as being in a specific language. 



[bookmark: _Toc296147666]Chart Web Part
The Chart Web Part is a Web Part that can be created and added to a SharePoint site to enable users to view performance and other types of information at a glance. For example, you can use a Chart Web Part to see sales amounts across different teams or geographical regions in a retail organization. 
[bookmark: _Toc268006380][bookmark: _Toc268792244]What kinds of charts can be displayed by using the Chart Web Part?
Charts can vary greatly in appearance and in the information that is displayed. For example, a bar chart that was created by using the Chart Web Part might resemble the following image:
[image: Chart Web Part]
Charts that are created by using the Chart Web Part are displayed as static images. This means that you can view up-to-date information in the chart, but you cannot click a value to see higher or lower levels of detail. Depending on how the chart is configured, you might be able to click hyperlinks that are connected to the chart series, legend, or data labels. 
However, there are many other ways to visually represent data by using the Chart Web Part. The following table describes the various chart types that are available with the Chart Web Part:
	Chart Type
	Description

	Bar chart
[image: Bar Chart]
	A bar chart illustrates comparisons among individual items.

	Area chart
[image: Area chart]
	An area chart is used to emphasize a degree of change over time, and also to show the relationship of its parts to a whole.

	Line chart
[image: Line Chart]
	A line chart can be used to illustrate trends in data with the passing of time.

	Point/Bubble chart
[image: Bubble Chart]
	Bubble charts display data points as bubbles of different size. The larger a data value, the larger a bubble is in the chart. Although the chart is called "bubble" it also can display different shapes, like Square, Diamond, Triangle and Cross.

	Financial chart
[image: Financial Chart]
	A financial chart is useful for displaying financial information, such as stock market values.

	Pie chart
[image: Pie Chart]
	A pie chart shows how proportions of data, shown as pie-shaped pieces, contribute to the data as a whole.

	Radar chart
[image: Radar Chart]
	A Radar chart, sometimes referred to as a Spider chart or Star chart, is a circular graph used primarily as a data comparison tool. These charts normally have a circular shape, but can also be displayed as a polygon.

	Gantt/Range Column chart
[image: Gantt Chart]
	Gantt charts, or Time charts, display separate events that have beginning and end values. These charts are excellent for planning the use of resources, and data can be plotted using either a date-time or numerical scale.

	Range chart
[image: Range Chart]
	The Range chart displays a range of data by plotting two Y values per data point, with each Y value being drawn as a line chart. The range between the Y values can then be filled with color, or an image.

	Error Bar chart
[image: Error Bar Chart]
	Error bar charts consist of lines with markers that are used to display statistical information about the data displayed in a graph. An Error Bar chart type is a series that has 3 Y values. Although these values can be assigned to each point in an Error Bar chart, the values are typically calculated from the data present in another series. 

	BoxPlot chart
[image: BoxPlot Chart]
	The BoxPlot chart type consists of one or more box symbols that summarize the distribution of the data within one or more data sets. A Box Chart displays a rectangle with whisker lines extending from both ends. 

	Funnel chart
[image: Funnel Chart]
	The Funnel Chart type displays data that equals 100% when totaled. This type of chart is a single series chart that represents the data as portions of 100%.

	Pyramid chart
[image: Pyramid Chart]
	The Pyramid chart displays data that equals 100% when totaled. The Pyramid chart can be displayed as a pyramid or conical shape.


Charts that are created by using the Chart Web Part are stored as site assets that are specific to the SharePoint pages where they were created. This means that you cannot reuse one particular chart across other pages. 
[bookmark: _Toc268006381][bookmark: _Toc268792245]Why use a Chart Web Part?
Like most other kinds of charts you might see in SharePoint sites, the Chart Web Part makes it easy to view performance information at a glance. The Chart Web Part is also useful when you want to quickly and easily create a chart and add it to a SharePoint site without leaving the SharePoint site. 
Here are a few examples of when you might use a Chart Web Part:
· To quickly and easily create a chart that personalizes your view of a SharePoint site. 
For example, suppose that you are viewing a SharePoint site that contains performance or other types of information for a group or an organization. Suppose further that you want to add another report view to the page that displays particular information that you want to see. You can easily do this by using a Chart Web Part.
· To create a chart that uses data from another chart. 
One of the benefits of the Chart Web Part is that it is capable of both sending and receiving data. This means you can use one Chart Web Part as a data source for another Chart Web Part.
· To create and use a chart that connects to external data. 
For example, suppose that you want to create and use a chart that displays information from a customer relationship management (CRM) tool. If your organization uses Business Connectivity Services (BCS), you can connect the Chart Web Part to a BCS component to display that data. 
[bookmark: _Toc268792246]What kinds of data sources can be used with the Chart Web Part?
A Chart Web Part can use one of the following data sources:
· Another Web Part. You can connect the Chart Web Part to another Web Part that is capable of sending data. Examples of such Web Parts include a Document Library or a Contacts list.
· A SharePoint List. You can connect the Chart Web Part to a SharePoint list that is located in the same site collection.
· A Business Connectivity Services component. You can connect the Chart Web Part to a BCS component to display external or line of business data.
· An Excel Services file. You can connect the Chart Web Part to an Excel workbook that has been published to Excel Services.
Add a Chart Web Part to a Web Part Page
During this phase, you create or open a page for editing, and then you add a blank Chart Web Part to the page.
1. Begin by either creating a page or by opening an existing page for editing. 
2. On the ribbon, click the Insert tab, and then in the Web Parts group, click Web Parts. 
3. In the Categories section, click Business Data.
4. In the Web Parts section, click Chart Web Part, and then click Add.
5. Proceed to connect to a data source and configure the Chart Web Part.
[bookmark: Phase2][bookmark: _Phase_2:_Connect][bookmark: _Toc276035255]Connect to a data source and configure the Chart Web Part
During this phase, you select a data source connection and configure the Chart Web Part. 
Note Before you begin, make sure that the page that contains the Chart Web Part is in editing mode.
1. Locate the Chart Web Part that you want to edit, and then click the Data & Appearance hypertext.
2. In the Data Connection & Chart Appearance Wizards page, click Connect Chart to Data to open the Data Connection Wizard. 
3. In the Choose a Data Source page, select a data source type, and then click Next. You can choose from the options that are described in the following table: 
	Option
	Description

	Connect to another Web Part
	Use this option to connect the Chart Web Part to another Web Part that is capable of sending data. Examples of such Web Parts include a Document Library or a Contacts list.
Note Make sure that the Web Part that you want to use is already on the same page as the Chart Web Part.

	Connect to a List
	Use this option to connect the Chart Web Part to a list that is located in the same site collection.

	Connect to Business Data Catalog
	Use this option to you connect the Chart Web Part to a Business Connectivity Services (BCS) component. BCS enables integration with external data, including line of business applications. BCS builds on top of the Business Data Catalog technology that was delivered in Microsoft Office SharePoint Server 2007. 

	Connect to Excel Services
	Use this option to connect the Chart Web Part to an Excel workbook that has been published to Excel Services.


4. In the Connect to Data Source page, select the data source that you want to use, and then click Next. 
5. In the Retrieve and Filter Data page, preview the data that will be used for the Chart Web Part. 
6. To optionally configure parameters to display a subset of the data, use the following procedure:
1. Click the plus sign (+) next to Filters to expand the Define Filter Parameters section.
2. Use the Parameter Name list to select an item, such as a column in the data set. 
3. Use the Type list to select an appropriate operator type. 
4. Use the Default value box to specify the criterion that you want to use for the filter. 
5. Click Preview Data to view the filtered data. 
6. Repeat Steps 1-6 for each additional parameter that you want to use for the chart. 
7. After you have finished previewing and filtering the data, click Next.
8. To optionally specify how you want the data to be displayed, use the Bind Chart to Data page. Do this by specifying one column for the Y Field, and another column for the X Field.
9. Click Finish to view the chart in its page.
[bookmark: Phase3][bookmark: _Toc276035256]Change the appearance of the Chart Web Part
After you have created a Chart Web Part, you can change how the chart appears. For example, you can select a chart type and specify display settings, including themes, the chart title and legend, axes and grid lines, and so forth. 
Note Before you begin, make sure that the page that contains the Chart Web Part is in editing mode.
1. Locate the Chart Web Part that you want to edit, and then click the Data & Appearance hypertext.
2. In the Data Connection & Chart Appearance Wizards page, click Customize Your Chart to open the Chart Customization Wizard. 
3. In the Select Chart Type page, select a chart type by using the following procedure:
1. In the Chart Type Categories section, click a chart category. 
2. In the Chart Templates section, click a chart template
3. Click Next.
4. In the Chart Appearance Properties page, select a theme by using the following procedure:
1. In the Appearance Theme section, use the Theme list to select a theme for the chart.
2. If the Drawing Style list is available, use it to specify how you want the items in the chart to appear. For example, if you selected a pie chart type, then you can use the Drawing Style list to specify how the outer edge of the “pie” will display. 
3. Use the Transparency list to specify the level of opacity of the chart colors. For example, select 0% - Solid to display the chart in rich colors, and 100% - Invisible to display the chart as transparent (without any colors). 
5. To optionally specify the width, height, and image format that you want to use for the chart, use the Size and Format section. 
6. After you have configured the chart appearance properties, click Next.
7. To optionally specify settings, such as the chart title and legend, axes and grid lines, data labels, and other properties, use the Chart element properties page. 
To configure one or more of the chart element properties, select a tab, and then use the following procedures (as applicable): 
Title and Legend
	Section
	Procedure

	Titles
	1. Select the Show Chart Title check box.
2. In the Title box, type a name for the chart.
3. Use the Font list to specify a font type, size, and style for the chart title.
4. Use the color list to select a color for the chart title text.
5. In the Position section, click to specify where you want the chart title to display. 
6. Do one of the following:
1. Proceed to the Legend section.
2. Click another tab, such as the Axes and Grid Lines tab.
3. Click Finish to view the chart in its page.

	Legend
	1. Select the Show Legend check box.
2. Use the Legend Font list to specify a font type, size, and style for the chart legend.
3. In the Title box, type a name for the chart legend.
4. Use the Title Font list to specify a font type, size, and style for the title of the chart legend.
7. Use the color list to select a color for the chart legend title text.
5. To optionally overlay the chart legend on the chart, select the Dock to Chart Area check box.
6. Use the Style list to specify whether you want the chart legend to display as a table, a column, or as a row of items.
7. In the Position section, click to specify where you want the chart legend to display.
8. Do one of the following:
1. Click another tab, such as the Axes and Grid Lines tab.
2. Click Finish to view the chart in its page.


Axes and Gridlines 
	Section
	Procedure

	X-Axis 
or
Y-Axis
	Note Depending on the chart type that is used for the chart, you might or might not have the ability to format an axis or its gridlines. For example, if the chart is displayed as a pie chart, no options are available on the Axes and Gridlines tab. On the other hand, if the chart is displayed as a bar chart, many options are available on the Axes and Gridlines tab.
1. In the X-Axis (or Y-Axis) section, use the Show Axis list to show or hide an axis.
· Select Auto or True to display the axis.
· Select False to hide the axis. 
2. To display a title for the axis, use the following procedure:
1. Select the Show Axis Title checkbox.
2. In the Title box, type a name for the axis.
3. Use the Title Font list to specify a font type, size, and style for the name of the axis.
4. Use the Alignment list to specify where you want the name of the axis to be displayed. 
3. To show item names in the axis, use the following procedure:
1. Select the Show Axis Labels checkbox.
2. Use the Font list to specify a font type, size, and style for the axis labels.
3. Use the color list to select a color for the axis labels.
4. To optionally modify how the axis labels are displayed, use the Format list. For example, you can select a particular format for dates, if dates are used in an axis.
5. Select the Reversed checkbox to show axis labels across the top of the chart (as opposed to the bottom of the chart). 
6. Select the Interlaced checkbox to display shaded background rows in the chart. This is useful if the chart is large or contains a lot of bars or columns.
4. To adjust the scale of the axis, specify one or more of the following Axis Settings options:
· Select the Start from zero checkbox to include zero (0) in the range of values.
· Select the Logarithmic scale checkbox to change the scaling of the axis to use logarithmic values instead of actual values. This is useful if the chart covers a large range of values or when the equally spaced values are numbers that increase exponentially (such as 1, 10, 100, etc.) instead of consecutive values that increase linearly (such as 1, 2, 3, etc.).
· Select the Side margins checkbox to include whitespace on either side of the first and last items in the chart. For example, if the chart displays vertical bars, you might select the Side margins checkbox to configure the chart to show spacing between the edge of the chart and the edges of the first and last bars.
· Use the Minimum box to specify a minimum value for the axis.
· Use the Maximum box to specify a maximum value for the axis.
5. To show grid lines in the chart, use the following procedure:
1. Select the Show Major Grid Lines checkbox. Major grid lines appear as solid gray lines in the chart and are useful for making it easier to see approximate chart values. 
2. In the Interval box for the major grid lines, type a number that corresponds to the interval that you want to use for the major grid lines. For example, if the chart displays data in units of 100, you might type 100 for the interval to display major grid lines.
3. Use the Tick Marks list to specify whether and how tick marks will be displayed in the chart. Tick marks appear along an axis to make it easier to see approximate chart values. 
4. To optionally add another set of grid lines to the chart, select the Show Minor Grid Lines checkbox. Minor grid lines typically use smaller intervals than major grid lines.
5. In the Interval box for the minor grid lines, type a number that corresponds to the interval that you want to use for the minor grid lines. 
6. Use the Tick Marks list to specify whether and how tick marks will be displayed in the chart. Tick marks appear along an axis to make it easier to see approximate chart values. 
6. Do one of the following:
1. Proceed to the Secondary X-Axis or Secondary Y-Axis section.
2. Click another tab, such as the Data Labels and Markers tab.
3. Click Finish to view the chart in its page.

	Secondary X-Axis
or
Secondary Y-Axis
	A secondary X-Axis is typically displayed across the top of a chart, whereas a secondary Y-Axis is typically displayed along the right side of the chart.
Note Depending on the chart type that is used for the chart, you might or might not have the ability to display a secondary axis or its gridlines. 
1. In the Secondary X-Axis (or Secondary Y-Axis) section, use the Show Axis list to show or hide a secondary axis.
· Select Auto or True to display the axis.
· Select False to hide the axis. 
2. To display a title for the secondary axis, use the following procedure:
1. Select the Show Axis Title checkbox.
2. In the Title box, type a name for the axis.
3. Use the Title Font list to specify a font type, size, and style for the name of the axis.
4. Use the Alignment list to specify where you want the name of the axis to be displayed. 
3. To show item names in the secondary axis, use the following procedure:
1. Select the Show Axis Labels checkbox.
2. Use the Font list to specify a font type, size, and style for the axis labels.
3. Use the color list to select a color for the axis labels.
4. To optionally modify how the axis labels are displayed, use the Format list. For example, you can select a particular format for dates, if dates are used in an axis.
5. Select the Reversed checkbox to show axis labels across the top of the chart (as opposed to the bottom of the chart). 
6. Select the Interlaced checkbox to display shaded background rows in the chart. This is useful if the chart is large or contains a lot of bars or columns.
4. To adjust the scale of the secondary axis, specify one or more of the following Axis Settings options:
· Select the Start from zero checkbox to include zero (0) in the range of values.
· Select the Logarithmic scale checkbox to change the scaling of the axis to use logarithmic values instead of actual values. This is useful if the chart covers a large range of values or when the equally spaced values are numbers that increase exponentially (such as 1, 10, 100, etc.) instead of consecutive values that increase linearly (such as 1, 2, 3, etc.).
· Select the Side margins checkbox to include whitespace on either side of the first and last items in the chart. For example, if the chart displays vertical bars, you might select the Side margins checkbox to configure the chart to show spacing between the edge of the chart and the edges of the first and last bars.
· Use the Minimum box to specify a minimum value for the axis.
· Use the Maximum box to specify a maximum value for the axis.
5. To show grid lines in the chart, use the following procedure:
1. Select the Show Major Grid Lines checkbox. Major grid lines appear as solid gray lines in the chart and are useful for making it easier to see approximate chart values. 
2. In the Interval box for the major grid lines, type a number that corresponds to the interval that you want to use for the major grid lines. For example, if the chart displays data in units of 100, you might type 100 for the interval to display major grid lines.
3. Use the Tick Marks list to specify whether and how tick marks will be displayed in the chart. Tick marks appear along an axis to make it easier to see approximate chart values. 
4. To optionally add another set of grid lines to the chart, select the Show Minor Grid Lines checkbox. Minor grid lines typically use smaller intervals than major grid lines.
5. In the Interval box for the minor grid lines, type a number that corresponds to the interval that you want to use for the minor grid lines. 
6. Use the Tick Marks list to specify whether and how tick marks will be displayed in the chart. Tick marks appear along an axis to make it easier to see approximate chart values.
6. Do one of the following:
1. Click another tab, such as the Data Labels and Markers tab.
2. Click Finish to view the chart in its page.


Data Labels and Markers 
	Section
	Procedure

	Labels
	1. Select the Show Labels checkbox to display labels, such as values, in the chart.
2. Use the Label Value list to select the type of labels that you want to display. For example, to show values that are in the data source that is used for the chart, select Show default values.
3. Use the Font list to specify a font type, size, and style for the data labels.
4. Use the color list to select a color for the data labels.
5. To optionally modify how the data labels are displayed, use the Format list. For example, you can select a particular format for dates, if dates are used in the chart.
6. To optionally display data labels at an angle in the chart, in the Label Angle box, type a number. The number that you type corresponds to how many degrees clockwise that you want to display the data labels. For example, to display the data labels at a slight, downward angle, you might type “10” in the Label Angle box.
7. Use the Label Alignment list to specify where you want the data labels to appear in the chart. For example, to display the data labels outside actual chart values, select Outside in the Label Alignment list.
8. Do one of the following:
1. Proceed to the Data Markers section.
2. Click another tab, such as the Hyperlinks and Tooltips tab.
3. Click Finish to view the chart in its page.

	Data Markers
	1. Select the Show Markers checkbox to highlight data points in the chart. 
2. Use the Marker Style list to select the type of marker that you want to use. 
3. In the Marker Size box, type a number to specify the size (in pixels) of the data markers that you want to use.
4. Do one of the following:
1. Click another tab, such as the Hyperlinks and Tooltips tab.
2. Click Finish to view the chart in its page.


Hyperlinks and Tooltips
	Section
	Procedure

	Hyperlinks and Tooltips
	You can add hyperlinks and tooltips to three types of items in the Chart Web Part: 
· A chart series (which corresponds to bars in a bar chart) 
· The chart legend
· Data labels in the chart 
You can use hyperlinks to direct chart users to other sites that contain additional information. You can use tooltips to display comments or notes as additional information in the chart. 
Note Chart users will only see tooltips and hyperlinks when they position their mouse over a particular chart element. For example, in order to see a series tooltip or click a hyperlink in a bar chart, the chart user must position the mouse over a bar in the chart.
1. Use the Data Series list to select the data series for which you want to add a hyperlink or a tooltip. 
Note If the chart contains only one data series, the Data Series list contains only Default.
2. Use the Series Hyperlink box to specify a website address (URL) to a site, such as a website or a team site. In the chart, the hyperlink will be attached to series items, such as bars in a bar chart.
3. Use the Series Tooltip box to type information, such as a note, that will be displayed when a chart user positions the mouse over a series item, such as a bar in a bar chart.
4. Use the Legend Hyperlink box to specify a website address (URL) to a site, such as a website or a team site. In the chart, the hyperlink will be attached to the chart legend.
5. Use the Legend Tooltip box to type information, such as a note, that will be displayed when a chart user positions the mouse over the chart legend.
6. Use the Label Hyperlink box to specify a website address (URL) to a site, such as a website or a team site. In the chart, the hyperlink will be attached to data labels in the chart.
7. Use the Label Tooltip box to type information, such as a note, that will be displayed when a chart user positions the mouse over a data label in the chart. 
8. Do one of the following:
1. Click another tab, such as the Title and Legend tab.
2. Click Finish to view the chart in its page.


[bookmark: _Toc296147667]Table of Contents Web Part
Good navigation is one of the keys to a successful Web page. In Microsoft SharePoint Server 2010, you can enhance the navigation functionality of a Web page by using a Table of Contents Web Part (Web Part: A modular unit of information that consists of a title bar, a frame, and content. Web Parts are the basic building blocks of a Web Part Page.).
[bookmark: _Toc257122014]What is a Table of Contents Web Part?
A Table of Contents Web Part is a configurable component that you can add to a SharePoint page. You use the Table of Contents Web Part to automatically generate a site map that points to various parts of your SharePoint Server 2010 site collection.
When you add a Table of Contents Web Part to a page, you specify which part of your site collection the Web Part should generate links to, how the links are presented, and how the links are organized.
[bookmark: _Toc257122015]When can I use a Table of Contents Web Part?
You can use a Table of Contents Web Part to provide navigation links on any page by adding a Table of Contents Web Part to a page. If your site administrator has included it as an option on the site, you can also use the Welcome page with table of contents page layout when you create a new page on the site. This layout creates a page that already contains a Table of Contents Web Part.
[bookmark: _Toc257122016][bookmark: BMuse_toc][bookmark: _Toc257122018]Configure the Table of Contents Web Part 
1. When you add the Table of Contents Web Part to a page, it automatically displays the document libraries, lists, and other content on your site. You can customize the display and navigation of your Table of Contents Web Part from the tool pane. Click the arrow at the top-right corner of the Web Part, and then click Edit Web Part. 

[image: Edit Web Part]

The Table of Contents Web Part tool pane opens.

[image: Table of Contents Web Part tool pane]
2. In the Content section, set the following options:
· Start from This option determines the root level from which content is included. All of the content that is exposed by the Table of Contents Web Part must be: a page that is in this root site, a site that is in this root site, or a page that is in a site that is in this root site. Click the Browse button, and then choose the site that you want to use as the root of the Web Part.
· Levels to show Use this option to specify how many levels of navigation the Web Part displays. The root site is at the first level of navigation, each site that is directly below the root site is at the second level of navigation, and so on. Pages are at the same navigation level as the site to which they belong.
For example, suppose you have chosen a root site called Home that contains two sites, called News and Announcements, and that each of those sites contains four sites, called Quarter 1, Quarter 2, Quarter 3, and Quarter 4. If you specify that the Table of Contents Web Part displays two levels, it does not display the Quarter sites, because they are at the third level of navigation. However, in this example, pages that belong to the News site and the Announcements site are displayed, because they belong to sites that are at the second level of navigation.
· Show content from starting location Select this check box if you want the Web Part to show links to pages that are directly under the root that you specify by using the Start from option. If you do not select this check box, the Web Part displays sites that are directly under the root, and pages and sites that are under those sites, but does not display pages that are directly under the root.

Note If you select Show content from starting location, the Table of Contents displays in one column.
· Show pages If you want the Web Part to display links to pages as well as links to sites, you must select this option. If this option is clear, only links to sites display in the Web Part.
· Include hidden pages Select this option if you want the Web Part to display links to pages that are hidden from navigation.
· Include hidden sites Select this option if you want the Web Part to display links to sites that are hidden from navigation.
3. In the Presentation section, set the following options:
· Header Text You can add text to the Web Part header by typing it in this box. The header text appears directly below the Web Part title.
· Header Style If you add header text, you can also specify the style of that text by using this option. Select a style from the drop-down list.
· Display Columns Use this option to set the number of columns that are displayed by the Web Part. Links are arranged in the number of columns that you specify by using the drop-down list.

Note This option has no effect if you select Show content from starting location in the Content section, which causes the Web Part to display only one column.
· Level 1 Style You can specify the display style for the links that are at the first level of the Web Part navigation hierarchy by using this option. Level 1 links point to items that are directly under the root level you specify by using the Start from option in the Content section.
· Level 2 Style You can specify the display style for the links that are at the second level of the Web Part navigation hierarchy by using this option. Level 2 links point to items that are directly under Level 1 links. This option has no effect if you set the Levels to show option (in the Content section) to 1.
· Level 3 Style You can specify the display style for the links that are at the third level of the Web Part navigation hierarchy by using this option. Level 3 links point to items that are directly under Level 2 links. This option has no effect if you set the Levels to show option (in the Content section) to 1 or 2.
4. In the Organization section, set the following options:
· Sort contents as they are sorted in navigation Select this option to cause the Web Part to use the same sort order that is used in the site navigation settings.
· Sort contents using the following settings Select this option if you want to specify the sort order that the Web Part uses. If you select this option, the following sort options are available:
· Sort Sites By This option allows you to specify which property of the sites is used for sorting the links to those sites. There are three properties that you can use for sorting: Title, Creation Date, and Last Modified Date.
· Sort Direction Use this to select a sort direction to apply to the sorted site links. For example, you can sort the sites by Title in alphabetical order by setting Sort Sites By to Title and setting Sort Direction to Ascending.
Sort Pages By This option allows you to specify which property of the pages is used for sorting the links to those pages. There are three properties that you can use for sorting: Title, Creation Date, and Last Modified Date.
· Sort Direction Use this to select a sort direction to apply to the sorted page links. For example, you can sort the pages by Title in alphabetical order by setting Sort Pages By to Title and setting Sort Direction to Ascending.
5. At the bottom of the tool pane, click OK to save your changes and close the tool pane.
[bookmark: _Toc296147668]Filter Web Parts
Filter Web Parts change the view of the data displayed in another Web part based on certain criteria. For example, a filter Web Part might cause a financial report to display only values from a specific year, or cause a list of students in a class to display only the names of students who have completed a particular assignment. 
The Filter Web part might display a filter icon on the page and require user input, such as a date or text, to create filter criteria. Alternatively, the Filter Web Part might operate automatically; it might not appear on the page, and might use criteria for filtering that are supplied from a third Web Part, such as a Current User filter. Filter Web Parts that are not visible on the page are called context Web Parts; they filter results automatically without user input.
Filter Web parts work with SharePoint lists, data from Microsoft SQL Server versions 2005 and 2008 Analysis Services, and data that resides in the Business Connectivity Services.
[bookmark: _Toc257196972]Ways to use filters
The following scenarios illustrate two of the many ways that you can use filter Web Parts:
· Jeff Smith wants to communicate the revenue generated by a product on a monthly basis. Historically, Jeff viewed a SQL Server Analysis Services report produced by the Contoso Sales application, and then copied the information into an e-mail message to distribute it to his team.
Now, Jeff adds the same SQL Server Analysis Services report to his dashboard on a monthly basis, along with a report that shows customer complaints by product. Jeff adds a filter Web Part so that dashboard users can pick the product they are interested in. He sets up the filter to show a list of products, and he connects the filter to both the new customer complaints by product monthly report and the existing product revenue by month report. When his team members view the page, they can see data on the default product Jeff set for the reports, but they can also pick any product from a list. When a team member chooses a different product, the filter changes all of the data in each of the connected Web Parts.
· Christina Lee, a regional sales manager, uses her division's dashboard to review monthly data. She notices that the customer satisfaction key performance indicator (KPI) is yellow, indicating it is in warning mode. She can click the indicator to go to a Web page that displays the indicator, an explanation of why it is yellow and three reports that provide additional insight.
The filter displays only the page elements that apply specifically to Christina’s division. Other sales managers in Christina's company can view the same dashboard, but their view is different. The filter customizes each view for a particular division.
[bookmark: _Toc257196973]Types of filters
The type of filter Web Parts you use and how you use them depends on your data source, the type of interaction you want from the user, and the results you want. There are nine types of filters provided with Microsoft SharePoint Server 2010 along with the Filter Actions Web Part, which enables you to add a filter button to a page so that users can choose when to refresh the data on the page.
The following filter Web Parts allow users to specify the values manually that will filter the data displayed on the page:
	Web Part
	Description

	Date Filter
	You can provide a default or leave the value blank. Users can pick a date from a drop-down calendar or enter the m/d/yyyy value into the box displayed on the Web page.

	Text Filter
	You can require that users enter text and/or provide default text.


The following filter Web Parts allow users to pick from a list of values:
	Web Part
	Description

	Choice Filter
	The choice filter allows you to specify values in the tool pane of the Web Part. Users select one of the values from a drop-down menu that appears on the page.

	Business Data Connectivity Filter
	This Web Part allows you to specify a list of values from the Business Data Catalog and then specify Value column. In addition, you can add a Description column.
For example, if the entity is Products the AdventureWorks application and the Value column could be Name. If you add a Description column, this filter Web Part adds a picker dialog that enables the user to use a drop-down list to search for products by Description, Key, or Name.

	SharePoint List Filter
	When you configure this filter, you point to a SharePoint list and specify the value of a column, such as title, description, date, or document type. Users can browse to the list and then choose from the type of item you specify.

	SQL Server Analysis Services Filter
	This filter allows you to select a data connection from a Web Part on the current Web page or from a SharePoint Data Connection library or Office Data Connection library. You then specify a dimension and hierarchy. Users can choose from the resulting list of values. 


These filter Web Parts automatically filter the data that displays on the Web page:
	Web Part
	Description

	Current User Filter
	Provides either the current user’s login name or a selected SharePoint profile property 

	Query String (URL) Filter
	Passes a fixed value(s) from another source that you configure in the tool pane

	Page Field Filter
	Provides the value of a column on the list row that is associated with the current page


[bookmark: _Toc257196974]Using filters
There are three steps to using a filter:
· Add the filter to the Web page
· Configure the filter settings
· (Optionally) Connect the filter to other Web Parts on the page
Add a filter Web Part to a page
Adding a filter Web Part to a page is similar to adding any other Web Part to a page. When using a filter that will request user input, consider the placement of the Web Part on the page. In addition, the name that you specify for the filter in the tool pane serves as the description on the page for the text box or menu.
Configure the filter settings
You configure the settings of your filter by using the Web Part tool pane. Each tool pane has different options depending on the type of filter you are setting up. 
Connect the filter to other Web Parts on the page
You might have to connect the filter Web Part that you use to another Web Part on the page. This might be the case when you use filters with Excel Web Access Web Parts. You can connect filter Web Parts that are either visible or invisible to the user. A visible filter Web Part may request input from the page viewer, such as selecting from a product list. An invisible filter Web Part, such as the Current User filter, automatically filters the data in the target Web Part based on the person who is logged on to the computer. 
When a filter is available that you can connect to another Web Part on the page, the Connections menu is visible from the Web Part menu. You can initiate a connection between the filter Web Part and another Web Part on the page from either Web Part.
[bookmark: _Toc296147669]HTML Form Web Part
You can use the HTML Form Web Part to connect to and pass data to another Web Part, such as the List view Web Part.
[bookmark: _Toc264880595][bookmark: _Toc274731120]Using the Form Web Part
You can use the HTML Form Web Part to connect and pass data to another Web Part. For example, you can use the default HTML Form Web Part to type a region name, pass the value to a List View Web Part of customer data, and filter the data by that region. You can also customize the HTML Form Web Part to enable a user to, for example, select the region name from a drop-down list. You can use text boxes, drop-down lists, multi-line text boxes, check boxes, or option buttons in the HTML Form Web Part. 
The way you connect fields to the other Web Part depends on how the other Web Part has been defined to use Web Part connections. 
Although you can have more than one element (text box, radio buttons, and so on) on your form, only one field can be connected to a List View Web Part. However, different fields can be connected to different Web Parts at the same time. For example, you can have an HTML Form Web Part with a text box and a set of option buttons. The text box can be connected to one List View Web Part and the option buttons to another. When the user clicks the Go button, both List View Web Parts are filtered according to the information entered on the HTML Form Web Part.
You can connect two or more fields in the HTML Form Web Part to another Web Part, if that Web Part can accept multiple parameters. In this case, you may need a SharePoint-compatible Web design program, such as SharePoint Designer 2010 to complete the connections.
[bookmark: _Toc274731121][bookmark: _Toc274731122]Connect the HTML Form Web Part to another Web Part
To use the HTML Form Web Part, you connect it with another Web Part that is capable of receiving values through a Web Part connection, such as the List View Web Part. The list you want to filter, and the column on which you want to filter it, must be visible in a Web Part on the same page as the HTML Form Web Part. 
1. Browse to the page containing the Web Part you want to filter.
2. In the ribbon, click the Page tab, and then click the Edit command.
Note If the Edit command is disabled, you may not have the permissions to edit the page. Contact your administrator.
3. Point to the HTML Form Web Part, click the down arrow, click Connections, point to Provide Form Value To, and then click the name of the Web Part to which you want to link. 
4. In the Choose Connection dialog box, click the Configure Connection tab.
5. From the Connection Type menu, select the field that matches the information from the HTML Form Web Part. Note The fields do not have to have the same names, nor do they have to be the same data types. The values sent from the HTML Form Web Part are text values.
6. Click Finish, and then click Exit Edit Mode at the top of the page. 
By default, you can enter text in the text box and then click Go or press ENTER. The other Web Part will display only the data that matches the text you entered. To clear the text box so that you can enter new text, select the current text, and then delete it. 
[bookmark: _Toc264880598][bookmark: _Toc274731123]Customize the HTML Form Web Part
You can customize the HTML Form Web Part by using either the Source Editor, which is available from the HTML Form Web Part tool pane, or a SharePoint-compatible Web design program, such as SharePoint Designer 2010. Instead of the standard text box, you can use option buttons, check boxes, multi-line text boxes, and list boxes. You can also add labels and assign a default value. 
If you customize the HTML Form Web Part, keep in mind the following:
· Only one Go button (which uses the INPUT element) can be used to pass data to another Web Part.
· The HTML Form Web Part uses the FORM element. Certain HTML elements cannot be used inside the FORM element, including the HTML, BODY, and FORM elements.
· All form field names must be unique. Each name value is used to connect to a corresponding column name in the Web Part that you are connecting to.
To customize the Form Web Part, use the Source Editor button to display the Text Editor dialog box and then revise or add the HTML source code.
Note The HTML Form Web Part only provides data to another connectable Web Part — it cannot get data from another connectable Web Part. For example, you cannot use the HTML Form Web Part as a detail form to display a row of data.
[bookmark: _Toc274731124]Customize the default HTML Form Web Part
To customize the default HTML Form Web Part, do the following:
1. From the page displaying the HTML Form Web Part, in the Ribbon, click the Edit tab, and then click the Edit command.
2. Point to the HTML Form Web Part, click the down arrow, and then click Edit Web Part.
3. On the tool pane, click the Source Editor button.
4. The Text Entry dialog box opens with the default HTML code. 
To make the code easier to read and modify, insert carriage returns in the text to break the lines as shown here: 
<div onkeydown="javascript:if (event.keyCode == 13) _SFSUBMIT_">
<input type="text" name="T1"/>
<input type="button" value="Go" onclick="javascript:_SFSUBMIT_"/>
</div>
You can change the first INPUT element in several ways by changing the name of a field, adding a label to a field, or adding a default value. 
	Property
	Description

	Field name
	The name of the default text box in the Form Web Part is T1. This is the name that appears in the Configuration Connection dialog box. To give the field a more meaningful name, type a new name in place of T1. Do not remove the quotation marks.

	Field label 
	You can add label text before or after the form field. Type the text without quotations marks. 

	default value
	You can add a default value to the text area field. The user can accept the value by clicking the Go button, or override it by typing their own entry. To add a default value, use the value attribute. 


For example if you want to provide a more meaningful name, add a default value, and add a label, you can do the following:
Region: <input type="text" name="Region" value="India"/>
You can change the second INPUT element by changing the name of the button, as the following example shows:
<input type="button" value="SUBMIT" onclick="javascript:_SFSUBMIT_"/>
You can also add other HTML elements before and after the DIV element. For example, a very useful and simple way to enable the user to quickly refresh the page and reset the FORM elements is to add an anchor tag of the current page after the closing DIV element. For example:
<br/>
<a href="http://contoso/SitePages/CustByRegion.aspx">Refresh</a>
[bookmark: multiline][bookmark: _Multi-line_text_box]Important Do not change the other HTML code in the Text Editor dialog box. The HTML Form Web Part dynamically creates a scripting routine at run time to create the connection to the other Web Part. Do not modify the onkeydown or onclick event code, or you may unintentionally break the HTML Form Web Part.
[bookmark: _Toc274731125]Use a multi-line text box
The TEXTAREA element defines a multi-line text input control. The ROWS attribute specifies the number of lines that are visible in the text field. The COLS attribute specifies the width of the text area in characters. In the following example, the user sees a text box of 5 lines and 30 characters in width. When the user enters text in the box, the text will wrap at 30 characters. 
<textarea name="Region" rows=5 cols=30></textarea>
[bookmark: checkbox][bookmark: _Check_box][bookmark: optionbuttons][bookmark: _Option_Buttons]Tip Make sure there is no space in the source code immediately after the right angle bracket (>).
[bookmark: _Toc274731126]Use option buttons
Option buttons, also called radio buttons, provide mutually exclusive choices to a user. The following example displays three radio buttons. Use the same name for each radio button. It’s customary to add the labels after each button. If you want to format each radio button on a separate line, use the BR element.
<input type="radio" name="Region" value="India"/> India<BR/>
<input type="radio" name="Region" value="USA"/> USA<BR/>
<input type="radio" name="Region" value="Spain"/> Spain<BR/>
[bookmark: dropdown][bookmark: _Drop-down_list_of][bookmark: _Toc274731127]Use a drop-down list of choices
If there are many mutually exclusive choices, consider using a drop down list box by using the SELECT element. Each option appears as a separate choice in the list, but the user can only select one choice. The text after the closing angle bracket of the OPTION element is what appears in the drop-down list.
<select name="Region">
<option value="India">India</option>
<option value="USA">USA</option>
<option value="Spain"> Spain </option>
</select>
To provide a default value, such as Spain, do the following:
<option value="Spain" selected="selected"> Spain </option>
[bookmark: _Toc274731128]Use checkboxes
If there are several non-mutually exclusive choices, consider using checkboxes. Each option appears as a separate check box, and the user can select any or all choices. Using this option requires a Web Part that accepts multiple parameters as part of the Web Part connection.
<input type="checkbox" name="region1" value="India"/> India<BR/>
<input type="checkbox" name="region2" value="USA"/> USA<BR/>
<input type="checkbox" name="region3" value="Spain"/> Spain<BR/>
To provide a default value, such as Spain, do the following:
<input type="checkbox" name="region3" value="Spain" checked="checked"/> Spain<BR/> 
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